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Section 1 Safety information

Please read this entire manual before this equipment is unpacked, set up, or operated.
Pay attention to all danger, warning, and caution statements. Failure to do so could result
in serious injury to the operator or damage to the equipment.

D A N G E R
 

Indicates a potentially or imminently hazardous situation which, if not avoided, will result in death
or serious injury.

W A R N I N G
 

Indicates a potentially or imminently hazardous situation which, if not avoided, could result in
death or serious injury.

C A U T I O N
 

Indicates a potentially hazardous situation that may result in minor or moderate injury.

N O T I C E
 

Indicates a situation which, if not avoided, may cause damage to equipment. Information that
requires special emphasis.

1.1 Hazard information

W A R N I N G
 

This product can expose the user to chemicals with silica, crystalline (airborne particles of
respirable size), which is known to the State of California to cause cancer and birth defects or
other reproductive harm. For more information, go to www.P65Warnings.ca.gov.

W A R N I N G
 

If the user thinks that a sensor has water in the pressure housing: Disconnect the
sensor from any power supply. Put on safety glasses and make sure that the sensor is
pointed away from the body and other people. In a well ventilated area, use the purge
port (if the sensor is so equipped), or very SLOWLY loosen the bulkhead connector to
let the pressure release.

W A R N I N G
 

Sensors that use ultraviolet light sources (< 400 nm): Do not look directly at a UV light
source when it is on. It can cause damage to the eyes. Keep products that have UV
light sources away from children, pets, and other living organisms. Wear polycarbonate
UV-resistant safety glasses to protect the eyes when a UV light is on.

W A R N I N G
 

If the user thinks that the batteries have leaks, pressure may have built up inside of the
pressure housing. Follow ESD protocols to release internal pressure. Put on safety
glasses and protective gloves and make sure that the sensor is pointed away from the
body and other people. In a well ventilated area, very SLOWLY loosen the bulkhead
connector to release the pressure. Keep away from heat, sparks, flame, and other
sources of ignition. Do not smoke.
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C A U T I O N
 

The pressure housing contains Electrostatic Discharge (ESD) sensitive parts and
assemblies that are susceptible to damage from ESD. Follow ESD protocols:

• Put on protective eye wear before you open the pressure housing.
• Any electrostatic charge on the body of the human operator must be released

before the pressure housing is opened: put a hand on a grounded surface, or
better, wear a grounded antistatic wrist strap.

• At a minimum, wear short-sleeved antistatic clothing, such as cotton, or better,
wear an antistatic smock for this service activity. Do not wear a sweater, fleece or
polyester-based clothing.

• At a minimum, use a workstation with a wood or metal tabletop, or better, a
tabletop that dissipates static. Do not use a workstation with a synthetic or
polymeric-based tabletop.

N O T I C E
 

The manufacturer is not responsible for any damages due to misapplication of misuse of this
product including, without limitation, direct, incidental and consequential damages, and disclaims
such damages to the full extent permitted under applicable law. The user is solely responsible to
identify critical application risks and install appropriate mechanisms to protect process during a
possible equipment malfunction.

1.2 Equipment labels
Read all labels and tags attached to the equipment. Personal injury or damage to the
equipment could occur if not observed. A symbol on the equipment is referenced in the
manual with a precautionary statement.

Do not look directly at a UV light source when it is on. It can cause damage to the eyes. Keep products
that have UV light sources away from children, pets, and other living organisms. Wear polycarbonate
UV-resistant safety glasses to protect the eyes when a UV light is on.

EFUP e: No hazardous material exists over the threshold of GB/T 26572-2011 standard, China's
Requirements for Concentration Limits for Certain Hazardous Substances in Electrical and Electronic
Products. This product should be recycled after its environmentally friendly use period.

Electrical equipment marked with this symbol may not be disposed of in European domestic or public disposal
systems. Return old or end-of-life equipment to the manufacturer at no charge to the user.

Safety information
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Section 2 ECO™ V2 quick start guide

This quick start guide gives the steps necessary to set up and make sure that the ECO
V2 sensor operates and collects data before it is deployed.
Delivered items—

• ECO V2 sensor
• Twelve 3.6-volt AA-size lithium batteries (model-specific, shipped separately)
• Dummy plug and lock collar
• Spare parts kit (model-specific)
• Test stick (model-specific)
• USB drive with software and calibration or characterization information.

1. If the sensor is so-equipped, install the manufacturer-supplied batteries (Install
batteries on page 11):

a. Remove the end flange of the sensor.
b. Use a 7/64" hex key to loosen the captivating screw on the end flange and

disconnect the battery pack and remove it from the sensor.
c. Install new batteries.
d. Connect the battery pack to the sensor again and install the end flange again.

2. Install the manufacturer-supplied software on a PC. (Install and start software
on page 13).

3. Verify that the sensor operates and collects data (Verify sensor operation
on page 11:

a. Connect the sensor to the PC and start the software.
b. If necessary, supply external power to the sensor (models with no internal

batteries).
c. Push Connect to start communication with the sensor.
d. Push Start to collect data.
e. Remove and replace the protective cover on the optical face several times to

change the value of the collected data.
f. Push Stop to stop data collection.

4. Verify that the sensor transmits data (Transmit data on page 21):

• Push Transmit Data in the Dashboard and select "All Data" to transmit data
collected by the sensor to the PC.

• Open the file on the PC to look at the data.
5. Use the "Deployment Wizard" in the software to set up the sensor for a specific

deployment. (Deployment wizard on page 17)
6. If necessary, attach the sensor to the frame on which it will be deployed.
7. Make sure to do maintenance on the sensor at regular intervals. (maintenance)
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Section 3 Specifications

3.1 Mechanical
Contact Function MCBH-6-MP

1 Ground

2 RS232 RX

3 Analog out 1 

4 Voltage in

5 RS232 TX

6 Analog out 2 

3.1.1 Four optical measurements (Quad)

Depth rating 600 m 1000 m 6000 m 6000 m

Diameter 6.30 cm 8.08 cm 6.30 cm 6.30 cm

Length 13.36 cm 33.6 cm 11.49 cm 28.05 cm

Weight in air 1 kg 2 kg 1 kg 2 kg

Internal memory Y Y Y Y

Wiper + copper faceplate N Y N N

Internal batteries N Y N Y

Operation temperature range 0–30 °C

Storage temperature range -20–50 °C

3.1.2 Three optical measurements (Triplet)

Depth rating 600 m 1000 m 1500 m 2000 m 6000 m

Diameter 6.30 cm 8.08 cm 8.08 cm 6.30 cm 6.30 cm

Length 13.36 cm 33.6 cm 16.84 cm 13.36 cm 11.49 cm

Weight in air 1 kg 2 kg 1 kg 1 kg 1 kg

Internal memory Y Y Y N Y

Wiper + copper faceplate N Y Y N N

Internal batteries N Y N N N

Operation temperature range 0–30 °C

Storage temperature range -20–50 °C

3.1.3 Two optical measurements (FLNTU)

Depth rating 300 m 600 m 2000 m 6000 m

Diameter 6.3 cm

Length 29.78 cm 13.62 cm 13.7 cm 11.8 cm

Weight in air 2 kg 0.6 kg 0.6 kg 1 kg

Internal memory Y N N N

Wiper + copper faceplate Y N N N
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Internal batteries Y N N N

Operation temperature range 0–30 °C

Storage temperature range -20–50 °C

3.1.4 One optical measurement (fluorescence or scattering)

Depth rating 300 m 300 m 600 m 600 m 6000 m

Diameter 6.30 cm 6.30 cm 6.30 cm 6.30 cm 6.30 cm

Length 29.78 cm 13.62 cm 13.67cm 13.67 cm 11.8 cm

Weight in air 2 kg 0.6 kg 0.6 kg 0.6 kg 1 kg

Internal memory Y Y Y N N

Wiper + copper faceplate Y Y N N N

Internal batteries Y N N N N

Operation temperature range 0–30 °C

Storage temperature range -20–50 °C

3.2 Electrical

Input 7–20 VDC

Current draw, typical 60 mA @ 12 V

Current draw, single-arm wiper < 28.0 mA @ 12 V

Current draw, three-arm wiper < 70.0 mA @12 V

Current draw, low power 140 µA @12 V

Linearity 99%

3.3 Optical
Parameter Wavelength EX/EM Range, Resolution

Chlorophyll (Chl) 435 435/695 nm 0–400, 0.016 µg/L/count

Chlorophyll (Chl) 470 470/695 nm 0–400, 0.016 µg/L/count

Fluorescent Dissolved Organic Matter (fDOM) 370/460 nm 0–900, 0.016 ppb/count

Uranine (UR) 470/530 nm 0–400, 0.06 ppb/count

Phycoerythrin (PE) Rhodamine (RH) 530/595 nm 0–230, 0.03 ppb/count

Phycocyanin (PC) 630/680 nm 0–230, 0.03 ppb/count

Scattering 412, 440, 470, 488, 510, 530, 595, 630, 650,
676, 700, 720, 770, 780, 870, 880 nm

wavelength-dependent

Scattering, NTU 700 nm 0–350, 1.32E-03 NTU

Specifications
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3.4 Communication

Sample rate user-selectable to 8 Hz (default: 1 Hz)

Data storage Single measurement: 1048000 samples;
Dual measurement: 762000 samples;

Triplet measurement: 599000 samples;
Quad measurement: 493000 samples

RS232 output rate user-selectable, default: 19200 baud

Data resolution 16 bit

Digital output maximum 550,000 counts

Analog output signal 0–5 V

Data validation flags provided

RMS noise 2 counts

Instantaneous noise ±5 counts

Software UCI 4.0

3.4.1 Sample rates
Number of
channels

DataRateHz
(cmd)

Ave
(cmd)

RTC
(hardware)

TXRealtime
(cmd)

DataRateHz
Range (sample

rate, Hz)

OutStr setting (cmd)

One-channel

1 NA 1–35 No NA 1.0–13.8 OutStr=0,9,31,33,195 

1 1-8 NA No NA 2–8 

1 NA 1–35 Yes Yes 0.99–12.7 OutStr=0,3,7,31,33,195 

1 1-8 NA Yes Yes 1–8 

1 NA 1-35 Yes No 1.0–19.8 

1 1-8 NA Yes No 1-8 

Two-channel

2 NA 1-35 No NA 0.51-9.2 OutStr= 0,9,31,33,56,58,195 

2 1-8 NA No NA 1-8 

2 NA 1-35 Yes Yes 0.51–8.7 OutStr=0,3,7,31,33,56,58,195 

2 1-8 NA Yes Yes 1-8 

2 NA 1–35 Yes No 0.52-12.7 

2 1-8 NA Yes No 1-8 

Three-channel

3 NA 1-35 No NA 0.34-6.8 OutStr=0,9,31,33,56,58,81,83,195
 

3 1-8 NA No NA 1-6 

3 NA 1-35 Yes Yes 0.34–6.6 OutStr=0,3,7,31,33,56,58,81,84,
195 

3 1-8 NA Yes Yes 1-6 

3 NA 1 Yes No 0.35–9.3 

3 1-8 NA Yes No 1-8 

Specifications
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Four-channel

4 NA 1-35 No NA 0.26–5.5 OutStr=0,9,31,33,56,58,81,83,
106,108,195 

4 1-8 NA No NA 1-5 

4 NA 1-35 Yes Yes 0.26-5.3 Outstr=0,3,7,31,33,56,58,81,83,
106,108,195 

4 1-8 NA Yes No 1-5 

4 NA 1 Yes No 0.26-7.4 

4 1-8 NA Yes No 1-7 

Notes

• Sample timing measurements used the OutStr value shown in the table above. If the
user changes the OutStr, the permitted sample rates and timing will be affected.

• For highly accurate sample timing, use the DataRateHz command. The "Ave"
command is available to configure sample rates to non-integer values. If the ECO
V2 is configured this way, it will create an offset error between the reported sample
rate and the actual sample rate. The timing error is a constant offset in the sample
rate, but the rate of error will not change while data is collected, so the sensor will
have a deterministic sample interval.

• An ideal sample would take the average of more than 1 sample, but ECO V2 lets the
user enter Ave=1. If this value is used, the actual sample rate may be up to 50%
faster than the reported value. This reported error comes from conservative timing
limits and optimization routines designed for routines where Ave > 1.

• If the sample rate is set to Ave=33, the actual rate may be up to 10% faster than the
reported value.

• When data is collected with txrealtime enabled, or an ECO V2 with no memory is
used, the OutStr value and BaudRate affect the sample timing.

• Sensors without memory/RTC have samples rates that will change by approximately
± 1Hz with temperature.

Setup: ECO V2 with firmware version 3.10.1b7626
Wiper timing:
Single-arm wiper—nominal time for a single wipe is 2.7 seconds
Three-arm wiper—nominal time for a single wipe is 1.4 seconds

Specifications
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Section 4 Verify sensor operation

Make sure the sensor operates, collects, and transmits data and then set up the sensor
for deployment.

4.1 Install batteries

W A R N I N G
 

Explosion hazard. If the batteries are not installed correctly, explosive gases can be
released. Make sure that the batteries are of the same approved chemical type and are
inserted in the correct orientation.

W A R N I N G
 

If the user thinks that a sensor has water in the pressure housing: Disconnect the
sensor from any power supply. Put on safety glasses and make sure that the sensor is
pointed away from the body and other people. In a well ventilated area, use the purge
port (if the sensor is so equipped), or very SLOWLY loosen the bulkhead connector to
let the pressure release.

W A R N I N G
 

If the user thinks that the batteries have leaks, pressure may have built up inside of the
pressure housing. Follow ESD protocols to release internal pressure. Put on safety
glasses and protective gloves and make sure that the sensor is pointed away from the
body and other people. In a well ventilated area, very SLOWLY loosen the bulkhead
connector to release the pressure. Keep away from heat, sparks, flame, and other
sources of ignition. Do not smoke.

C A U T I O N
 

The pressure housing contains Electrostatic Discharge (ESD) sensitive parts and
assemblies that are susceptible to damage from ESD. Follow ESD protocols:

• Put on protective eye wear before you open the pressure housing.
• Any electrostatic charge on the body of the human operator must be released

before the pressure housing is opened: put a hand on a grounded surface, or
better, wear a grounded antistatic wrist strap.

• At a minimum, wear short-sleeved antistatic clothing, such as cotton, or better,
wear an antistatic smock for this service activity. Do not wear a sweater, fleece or
polyester-based clothing.

• At a minimum, use a workstation with a wood or metal tabletop, or better, a
tabletop that dissipates static. Do not use a workstation with a synthetic or
polymeric-based tabletop.

The manufacturer ships the 12 lithium batteries for the sensor separately. Do the steps
below to install or replace the batteries. Also see the "how to" video on the manufacturer's
website to do this procedure.

Do not ship assembled battery packs Lithium batteries are packaged in heat-sealed plastic and bubble-wrap.
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Table 1  Recommended lithium battery brands
SAFT LS-14500 (included) 3.6 V, 2.6 Ah

Tadiran TL-4903 3.6 V, 2.4 Ah

Electrochem BCX85 series 3.9 V, 2.0 Ah

1. Make sure that the end flange and pressure housing are dry.
2. Use a 9/64" hex key to remove the two screws on the sides of the pressure housing.
3. Install these two screws into the sides of the end flange to start to loosen the end

flange.

4. Turn the end flange counter-clockwise to loosen it from the pressure housing.
5. Pull gently to disconnect the battery wires in the end flange from the battery pack.
6. Use a lint-free tissue to remove any water from the O-ring surfaces inside the

pressure housing and end flange.
7. Use a 7/64" hex key to loosen the captured screw in the battery cover plate.
8. Remove the battery pack from the pressure housing.
9. Turn the yellow cover plate counterclockwise to remove it from the battery pack body.
10. Move each of the two O-rings on the outside of the battery holder from the grooves.

It makes it easier to remove or insert batteries.

11. If necessary, remove the size AA batteries in the pack.
12. Insert new batteries.

Make sure to alternate the positive (+) and the negative (-) ends on the size AA
batteries to agree with the labels on the pack as they are installed.

13. Move the O-rings back into the grooves.
14. Align the pin on the yellow battery cover with the post hole in the battery pack

assembly.

Verify sensor operation
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15. Align the "D"-shaped part of the battery pack with the pins on the shaft.
16. Slowly move the assembly onto the housing. Push gently to connect the battery

assembly with the circuit board in the pressure housing.
17. Use a 7/64" hex key to tighten the captured screw on the yellow battery cover onto

the shaft in the pressure housing.
18. Attach the Molex connector on the end flange to the connector in the pressure

housing.

19. Examine the O-rings on the end flange. They must be pristine, with no lint or
scratches or chips.

• Apply a small quantity of Parker Super O Lube® to any new O-rings.
20. Align the end flange holes with the holes in the pressure housing.
21. Carefully push the end flange into the pressure housing.

It may help to rotate the end flange so that the wires do not bend too much.
22. If necessary, use a 9/64" hex key to remove the two screws from the end flange.
23. Use a 9/64" hex key to install the two screws into the pressure housing of the sensor

again.

4.2 Install and start software
Install the manufacturer-supplied software and make sure that the sensor is ready to test
for functionality before configuration and deployment. If the sensor is so equipped, install
the batteries if necessary. The manufacturer-supplied UCI software communicates with a
number of sensors. The sensors that are supported are listed in the Sensor menu of the
software.

1. Get the software from the manufacturer's website or the manufacturer-supplied USB
drive.

2. Install the appropriate software.

a. For Windows®: Double-click on the file with ".exe" appended to the name.

Verify sensor operation
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b. For Mac OS X®: Double-click on the file with ".pkg" appended to the name. Make
sure that the default "Install for all users on this computer" is selected as the
destination for the installed software. If "Install for me only" or "Install on a
specific disk" is selected, the software will not connect to the sensor.

3. Push Run in the new window.
The setup wizard starts.

4.3 Verify operation
Do the steps below to make sure the sensor operates, collects, and stores data before
further setup and deployment. Note that the sensor collects and stores (if equipped with
memory) all available parameters. The user can use the software to see a subset of the
collected data. Refer to Output description on page 19 for an example of the data that
the sensor collects.

1. Connect the test cable to the sensor, the PC, and a regulated power supply set at
12 V.

2. If necessary, start the software.
3. If necessary, go to the UCI menu, then Preferences to look at or change the

directory in which collected data will be stored.
4. Push OK to save any changes, or Cancel if no changes were made to the "Default

Data Directory."
5. Push Connect in the Dashboard area or from the Sensor menu item at the top of the

UCI window.
Refer to Sensor dashboards on page 39 for details about the Dashboard area.

6. If necessary, change the "Instrument Type" to agree with the connected sensor.
7. Put a check in the "Try All Baud Rates" box.

The software automatically finds the correct baud rate.
8. Push Connect.

The "Connection Mode" turns yellow, then green and the Mode changes to "Setup."
9. Push Get ECO V2 Settings in the Dashboard area of the connected sensor to look at

the parameters that will show in the output.
The Output Format tab shows. The basic output parameters are FrameSync, Header,
Time and Date, and engineering units for each of the channel(s) of the sensor.

10. Push Cancel.
Refer to Autonomous operation on page 17 for details to change the Output Format
settings.

11. In the Samples tab, put a check in the box next to "Sample Continuously" or set a
time interval between samples.

12. In the Transmit Data tab, put a check in the box for the sensor to transmit data in real
time to an externally connected logger or controller.
The default serial baud rate, typically 19200, is supplied by the software and does not
need to be changed.

13. Push Apply to store the settings in the sensor.
14. Push Select Sensors in the Time Series graph.
15. Put a check in the box next to any additional parameters, so that they will show in the

Time Series graph.
16. Push Start in the Dashboard area or use the Start icon (green circle with a white

arrow) under the UCI menu options.
The sensor collects data and stores it in the ECO V2. A Data Collection tab shows so
the user can choose Start Save to File so that the collected data is also saved to the
PC to look at before it is transmitted from the memory of the ECO V2. Change the
location to which the data is saved if necessary, or close the window.

Verify sensor operation

14



17. Let the sensor collect data for several minutes.
18. Push Stop in the Dashboard or use the icon under the UCI menu options.

The "Connection Mode" shows "Setup."
19. Optional: push Disconnect to disconnect the ECO V2.
20. Go to the directory on the PC in which the data was saved to see the collected data.

Verify sensor operation
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Verify sensor operation
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Section 5 Deployment and recovery

5.1 Deployment wizard
Use the deployment wizard in the UCI software to set up the sensor for either
autonomous or polled (controlled) operation.
To start the deployment wizard, go to either the Sensor menu or push Deployment
Wizard in the dashboard for the sensor.

5.1.1 Autonomous operation
1. Start the software if necessary.
2. Push Deployment Wizard in the dashboard of the connected sensor.
3. Select autonomous operation. Push Next.
4. Select the way data is transmitted from the sensor:

a. Put a check at "Transmit Data in Real Time" to see data in a connected controller
or PC as it is collected.
Note that if this is turned off, power consumption is reduced and the battery life is
extended.

b. Push Modify Format to change the parameters that are transmitted from the
sensor.

• "Field Format" is "Variable" or "Fixed."
• "Field Delimiter" is "Tab" or "Comma" or "Space."
• "Enable Checksum" enables a value at the end of each line of data, used by

the software to determine if there are data transmission errors.
• Select the desired output parameters from the applicable type of sensor at

the FDOM, CHL, Backscattering-530, Instrument, and Backscattering-700
tabs.

c. Push Next when complete, or if no changes are necessary. Refer to Output
description on page 19 for details about each parameter.

5. Select the frequency and interval of data collection:

a. Select a data rate: 1 Hz is the default of one sample/second.
b. Put a check in the box at "Sample Continuously" so that the sensor operates

continuously at the selected data rate, or
c. Remove the check and select the "Cycle Start Interval."
d. "Number of samples per Cycle": Enter a value of 1–86400.
e. "Number of cycles": enter a value of 0–65535.
f. Push Next.

6. Set the clock used by the sensor:

a. Push Synchronize ECO V2 clock to computer.
b. To erase the data stored in the sensor and set the event counters to 0, put a

check in the box.
7. Enter the date and time for the sensor to start data collection.
8. Battery endurance calculator:

a. The information in the Instrument tab is set by the manufacturer.
b. Use the manufacturer-supplied batteries and enter the "Minimum Deployment

Temperature" in the Environment tab.
c. The software helps the user calculate the life of other brands and types of

batteries.
d. Push Next.

9. Optional: make a deployment report:

a. Enter any information to be added to the deployment report.
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b. Push Browse to set the location on the PC to which the report will be saved.
c. The report will show on the PC if there is a check in the box at "View Report."

10. Push Finish to close the Deployment Wizard.
11. The sensor will start data collection at the user-specified date and time.

5.1.2 Polled operation
1. Start the software if necessary.
2. Push Deployment Wizard in the dashboard of the connected sensor.
3. Select polled operation. Push Next.
4. Push Modify Format to change the parameters that are transmitted from the sensor,

or push Next. Refer to Output description on page 19 for details about each
parameter.

5. Set the clock used by the sensor:

a. Push Synchronize ECO V2 clock to computer.
b. To erase the data stored in the sensor and set the event counters to 0, put a

check in the box.
6. Select the frequency and interval of data collection:

a. Enter the value for "Polling Interval" to set the start time of each interval.
b. "Number of samples per Poll": Enter a value of 1–86400.
c. Select a data rate: 1 Hz is the default of one sample/second.
d. Push Next.

7. Optional: make a deployment report.

a. Enter any information to be added to the deployment report.
b. Push Browse to set the location on the PC to which the report will be saved.
c. The report will show on the PC if there is a check in the box at "View Report."

8. Push Finish to close the Deployment Wizard.
9. The sensor will start data collection when directed by the controller.

5.2 Recover sensor from deployment
When the deployment is complete, remove the sensor from the water and if necessary,
connect it to a PC with the UCI software to turn it off. Disconnect the deployment cable,
and make sure to flush the connector and sensor with fresh water. Dry the optical face of
the sensor with lint-free tissues. Dry the sensor with a soft cloth or tissues. Immediately
attach the protective cover for the optical face and the dummy plug and lock collar to the
bulkhead connector.

Deployment and recovery
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Section 6 Transmit data

Data that is collected and stored by sensors must be transmitted to a PC to process the
data into a human-readable format.

6.1 Output description
The sensor always collects data for all parameters for which it was built. Data is collected
in binary. The UCI software converts the data into a .csv format.
The user can select which values to see as output. From the ECO V2 Settings window,
push Modify Format to see the options.
Field Format

• Variable (default setting): The output fields expand according to the size of the
individual output. There is only one delimiter without any extra whitespace. Each
record is the minimum size for each set of data.

• Fixed: The output fields are padded with leading spaces so each output field uses the
same space that a maximum value output would use. This makes each output record
the same length.

Field Delimiter

• Space: data units are separated by spaces.
• Comma: data units are separated by commas.
• Tab: data units are separated by tabs.

Enable Checksum Output
Turns on or off a CRC checksum value at the end of each line of data. The software uses
this to determine if there was an error when the data was transmitted and that data
should be ignored.

Parameter Description

FrameSync Enter the ASCII framesync-. Command must end with a "-".

FrameSyncHeader Shows the model and serial number of the sensor such as ECOv2 00102.

USDateFormat mm/dd/yy

EURODateFormat dd/mm/yy

ISO-DateTimeMS yyyy-mm-ddThh:mm:ss.ttt, where ttt is milliseconds

Time hh:mm:ss

TimeMS hh:mm:ss.ttt

Counter A sample that increments by 1 for each sample taken during a single burst. Counter reaches the
burst size as the burst is completed.

Countdown A counter that starts at the burst size and decrements by 1 for each sample taken during a single
burst. Countdown reaches 1 as the burst is completed.

SampleNumber A counter that starts at zero for the first sample and increments by 1 for each sample recorded. The
counter increments with each collected sample and is only reset with the memory is reset.

vMain The voltage of the input power supply or the input battery.

QASummary A single digit that shows the worst-case Quality Assurance-Quality Control of Real-Time
Oceanographic Data.

NumericQA A decimal display of the QARTOD status, with 1 digit for each parameter, a human-readable form of
the entire QARTOD status.

HexQA A hexidecimal display of the QARTOD status. Each HexASCII equals 2 QARTOD parameters. A
machine-readable form of the entire QARTOD status.
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Channel parameters (where x = 1–4, dependent on whether a sensor has 1, 2, 3, or 4 channels of output)

MxEX Excitation wavelength, nm

MxEM Emission wavelength, nm

MxHiGain High gain, counts

MxLoGain Low gain, counts

Mx 5 Volts Maximum voltage

MxLTC LED temperature compensation, counts

MxScaledRaw Raw output, counts

Mx Units Engineering output, µg/L

MxUnits Engineering units (µg/L, m-1 sr-1, ppb, NTU)

6.2 Output formats
The example below shows one possible output of user-selectable parameters for a
single-channel fDOM sensor. Sensors with two, three, and four output channels have a
tab for each additional available output format.
To modify the output:

1. Push Get ECO V2 Settings in the Dashboard area of the connected sensor.
2. Push Modify Format in the Output Format tab of the window that shows.
3. Select the parameters to see in the Modify Output Format window.
4. Push OK, then Apply.

Refer to Verify operation on page 14 for details to select output descriptions and formats.

Sensor descriptions Output format, fDOM

Single-channel fDOM with memory

TimeStamp FrameSync USDateFormat Time FDOM (ppb) FDOM ScaledRaw (counts) FDOM LTC (counts) FDOM 5 Volts

example output:

2025-01-T20:14:21.20.342.ECOV2-00012 01/30/25 14:21:20 4.069 795 365 54335 

Single-channel fDOM without memory

FrameSync Sample# FDOM (ppb) FDOM ScaledRaw (counts) FDOM LTC (counts) FDOM 5 Volts (counts)

Transmit data
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example output:

ECOV2-00012 2177 34.069 795 365 54335 

6.3 Transmit data
1. Push Transmit Data in the Dashboard area.

The Transmit Data window shows.

• Information in the Memory Summary lets the user see the available data storage
in the sensor.

• "Bytes" is the amount of memory in use.
• "Samples" is the number of samples the sensor has collected and stored.
• "Free Samples" is the number of samples the sensor can store.
• "Sample Length" is sensor-specific and shows the length of each data record

that the sensor stores.
2. In the "Transmit Type" drop-down menu in the Data Transmit Options area, select

either "All Data" or "Block size (bytes)."

• "All Data": all data stored in the sensor is transmitted to the PC in both .csv
and .sbsdat file types.

• "Sample Number Range": a user-specified range of samples. Select the specific
samples in the Sample Number Range area.

3. In the Data Transmit area, the software automatically selects the fastest baud rate to
use to transmit data, which is typically115200.
The software temporarily increases the sensor's baud rate to upload data more
quickly. After the transmission is complete, the software changes the baud rate to
what it was before data was transmitted.

4. In the Output CSV Data File area, type a new file name or use the automatically
generated file name.

5. Optional: change the time stamp to UTC.
6. Push Transmit.

• The data is transmitted to the PC.
• The software saves a raw .sbsdat file and automatically converts the data to a

readable .csv file type.
• The Transmit Progress window shows the status of the file transmission and

conversion.
• The default is a check in the boxes for "Show Data when Conversion Completed"

and "Close this Dialog when Conversion Completed."

6.4 QA data analysis
Use the data analysis filters to select the measurands and filters for data analysis. Start
the filters from either the sensor Dashboard or the Data menu. Refer to Data QAQC
on page 31 for details on sensor QAQC.

1. Enter the "File Name" or Browse to the .sbsdat file type to process. Push Open, then
Next in Step 1.

2. Put a check in the box next to any or all of the Pass, Suspect, or Fail criteria on which
to filter. Push Next.

3. Put a check in the box next to any or all of the parameters to filter. Push Next.
4. Enter any dark counts or scale factor values for a specific measurand. Push Next.
5. Enter the Median and Average Filter Size. Push Next.

Transmit data
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The sensor uses these values in its real-time calculation of raw and engineering units.
6. To change the directory in which the analysis will be saved, push Browse. Push

Finish for the software to start the analysis
The QA Analysis Graph shows next to the Time Series tab in the software.

7. Push Select Measurands and Filters for more options to filter data. Push OK.
The changes show in the graph.

8. To see a data file that has an analysis, go to Data, then ECO V2, and select Plot QA
Env Processed Data. Select the .csv file to plot, then select Open.
The data shows in the QA Analysis Graph. Push Select Measurands and Filters to
change the measurands that show.

6.4.1 QA data analysis output format
The output format from the data analysis operation is a comma-separated (.csv) file with
various measurands. The file name includes "analysis" instead of "Data." The example
below is from a sensor that measures backscattering and chlorophyll. Header information
is approximately 170 rows with information about the measurands selected for the
analysis.
The file starts with—
<!-- ECO V2 -->
<SBS_QA_File>
and ends with—
</QAProcessingSettings>
</SBS_QA_File>

.

.

.

.

.

.

The graph shows in the software next to the Time Series tab.

Transmit data
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6.5 Erase data stored in sensor
Sensors will append data as it is collected. If the memory is full, new data is saved over
the oldest data and will continue to do that until the memory is erased. This operation
erases all data stored in the sensor. It is not possible to select which data to erase.

1. Select the Sensor menu item.
2. Select the connected sensor.
3. Select Advanced.
4. Select Erase Data.
5. Push OK.
6. Push OK when the status in Clear Data Progress is 100%.

Transmit data
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Section 7 Maintenance

W A R N I N G
 

If the user thinks that a sensor has water in the pressure housing: Disconnect the
sensor from any power supply. Put on safety glasses and make sure that the sensor is
pointed away from the body and other people. In a well ventilated area, use the purge
port (if the sensor is so equipped), or very SLOWLY loosen the bulkhead connector to
let the pressure release.

The manufacturer recommends that the user returns the sensor for calibration at regular
intervals. The measurement accuracy of the sensor may decrease if the sensor is stored
unused for long periods of time.
The ECO V2 series of sensors has optional components that are the only user-
serviceable items:

1. One-or three-armed copper Biowiper and rubber blades—Refer to Remove and
replace wiper and clean faceplate on page 25 for details.

2. Copper faceplate—refer to Remove and replace wiper and clean faceplate
on page 25 for details.

3. Battery pack—refer to Install batteries on page 11 for details.
4. Pressure relief plug—refer to Maintain pressure relief plug on page 25 for details.

7.1 Remove or replace batteries
Refer to Install batteries on page 11 for details on these steps.

7.2 Maintain pressure relief plug
The manufacturer recommends that the user verify the functionality of the optional
pressure relief plug and the installed O-rings when the batteries are replaced to limit the
number of times the end flange is removed from the pressure housing.

1. Pull the pressure relief plug loose from the top of the end flange.
2. Dry the pressure relief plug.
3. Remove the end flange.

Refer to
4. Remove the screw on the inside of the end flange that holds the pressure plug.
5. Examine the size 110 O-rings on the pressure plug.
6. If it is necessary to replace the O-rings, apply a light coat of vacuum grease on any

new O-rings and then install them on the pressure plug.
7. Install the pressure plug into the end flange again.
8. Carefully tighten the screw on the inside of the end flange that holds the pressure

plug.
9. Make sure that the pressure relief plug is pushed all the way down on the end flange.

7.3 Remove and replace wiper and clean faceplate
Sensors that have copper face-plates and copper Bio-wipers need to be cleaned at
regular intervals to keep the copper effective as an anti-fouling aid. Remove the Bio-wiper
and faceplate from the sensor to clean them. See also the "how to" video on the
manufacturer's website to do this procedure.
Note: 

N O T I C E
 

Do not remove the copper ring. This will void the warranty.
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N O T I C E
 

Do not twist the Bio-wiper or the Bio-wiper shaft by hand. It will cause damage to the motor. Push
Check Wiper on the sensor Dashboard in the software to make sure that the Bio-wiper operates
correctly.

1. Disconnect the sensor from any power source.
2. Remove the wiper from the faceplate:

• For sensors with a single optical cutout, use the manufacturer-supplied 3/32" hex
key to loosen the screw that holds the Bio-wiper to the sensor.

• For sensors with three optical cutouts, use the manufacturer-supplied 1/16" hex
key to loosen the screw that holds the Bio-wiper to the sensor.

3. Lift the Bio-wiper off of the shaft.
4. Pull down on the long exposed part of the wiper to remove the rubber wiper from the

copper wiper arm.

5. Wet each wiper blade with isopropyl alcohol and push them into the bottom of the
copper wiper arm slot as shown.
It may be necessary to move the rubber back and forth to get it completely through
the slot. Put the wiper blade in the slot so that the top flat end of the wiper blade is
against the wiper arm as shown.

Single-blade Bio-wiper in correct position

Blade position pass/fail

6. Use a small Phillips screwdriver to remove the screws that attach the faceplate to the
optics face.

Maintenance
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7. Keep the screws.
8. Clean the Bio-wiper and faceplate with soapy water.
9. Rinse and dry thoroughly.
10. Use a Scotch-Brite® or similar pad to carefully buff the Bio-wiper, faceplate, and

copper ring until they are shiny.
11. Use an isopropyl alcohol-saturated cotton swab to clean the Bio-wiper shaft and the

shaft hole.
12. Make sure the Bio-wiper, faceplate, and copper ring are completely dry.
13. Attach the faceplate again.
14. Put the wiper arm onto the wiper arm shaft but do not tighten.
15. Put the wiper arm close to the optical face.
16. Make sure that the wiper is the correct height:

• Make sure that the rubber of all blades lightly touches the copper faceplate
evenly.

• Verify that a gap cannot be seen under every blade when all of the blades lightly
touch the copper faceplate. Adjust the blades in the wiper arm if necessary.

• The rubber will bend approximately 30 degrees against the optical face, which is
higher than the copper faceplate.

17. Use the appropriate hex key to tighten the wiper arm on the shaft. Do not over-
tighten.

7.4 Examine O-rings

N O T I C E
 

Do not use petroleum-based lubricants on O-rings. It will cause damage to the O-rings.
Damaged O-rings can cause the sensor to flood and make it unserviceable.

Examine the O-rings on the sensor every time they are exposed—on the connector end
flange and other parts. O-rings must be pristine. If there is any question about whether an
O-ring is clean and undamaged, replace it with a new one.

1. Dry the O-rings and O-ring grooves with a lint-free cloth or tissue.
2. Examine each O-ring to make sure there is no damage, dirt, lint or hair on it.

Maintenance
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3. Replace an O-ring if necessary.
4. Apply a small quantity of silicone-based Parker Super O Lube® or Dow Corning® high

vacuum grease to each O-ring.

• The lubricant helps the O-ring move into its groove with no twist, which can
compromise the seal.

• Do NOT use petroleum-based lubricants on any O-ring.

7.5 Clean bulkhead connectors

N O T I C E
 

Do not use WD-40® or petroleum-based lubricant on bulkhead connectors. It will cause damage to
the rubber.
Damaged connectors can cause a loss of data and additional costs for service.
Damaged connectors can cause damage to the sensor and make it unserviceable.
Use silicone-based lubricants only.

Examine, clean, and lubricate bulkhead connectors at regular intervals. Connectors that
are not lubricated increase the damage to the rubber that seals the connector contacts.
The incorrect lubricant will cause the failure of the bulkhead connector.

1. Apply isopropyl alcohol (IPA) as a spray or with a nylon brush or lint-free swab or
wipes to clean the contacts.

2. Flush with additional IPA.
3. Shake the socket ends and wipe the pins of the connectors to remove the IPA.
4. Blow air into the sockets and on the pins to make sure they are dry.
5. Use a flashlight and a magnifying glass to look for:

Any corrosion.

Cracks, scratches, or other damage on the
rubber pins or in the sockets.

Separation of the rubber from the pins.

Swelled or bulging rubber pins.

6. Use a silicone-based lubricant on each of the contacts of the bulkhead connector.
The manufacturer recommends any of the products listed below.

• 3M™ Spray Silicone Lubricant (3M ID# 62-4678-4930-3). Make sure to let it dry.
• Dow Corning Molykote® III Compound (DC III)
• Dow Corning High Vacuum Grease® (DC 976 V)

Maintenance
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• Dow Corning 4 Electrical Insulating Compound® (DC 4)
• Dow Corning Molykote 44 High Temperature Grease® (DC 44)

Use a finger to put a small quantity of 100% silicone grease or spray in the sockets or
on the pins. Use the mating plug or cable to help distribute the lubricant. Do not use
too much lubricant, as that will prevent a good seal.

7. Connect the connectors.
8. Use a lint-free wipe to clean any unwanted lubricant from the sides of the connectors.

7.6 Spare parts and accessories
Table 2  Anti-fouling parts, sensors with wipers

Part number Description Qty

BAA-JX0004 spare parts kit, which includes:

MAA-520001, orange fluorescent stick 1 

MAA-520002, green fluorescent stick 1 

MAA-520003, blue fluorescent stick 1 

GXA-SX0050, 3/32" short hex wrench 1 

GXA-SX0059, 1/16" short hex wrench 1 

MAA-907939, pop-in wiper blade 3 

Table 3  Battery kit
Part number Description Qty

BAA-JX0006 Battery spare parts kit, which includes:

50441, 12 size AA lithium batteries 1 

31755, 8-32 x ¼" titanium socket head cap screw 2 

GXA-HX0025, size 033 Buna-N O-ring 2 

GXA-HX0152, size 145 Buna-N O-ring 2 

XXX-GX0001, DC 111 grease, 6 grams 1 

GXA-SX0102, 9/64" short hex wrench 1 

Table 4  Accessories
Part number Description

FAS-519708 14½" flow-through housing

FAS-519709 3- and 4-measurement (Triplet-w, Quad-w) flow-through housing

7.7 Calibration
The manufacturer calibrates all scattering sensors to make sure that the data that is
collected meets the specifications for the sensor. The calibration information is stored in
the sensor. The user can use the software to see the calibration values.

7.8 Characterization
The manufacturer uses a fluorescent material to characterize all fluorescence sensors to
make sure that the data that is collected meets the specifications for the sensor. The
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characterization information is stored in the sensor. The user can use the software to see
the characterization values.

7.8.1 Field characterization
The manufacturer recommends that the user perform a field characterization on
fluorometers to make sure that the data is as accurate as possible for the user's
application. The scale factor and the dark counts values can vary depending on the
natural water, temperature, length of the cable, the power supply, and other factors.
Do the steps below to field-characterize the sensor.

• x = a solution of a known concentration in volts or counts.
• output = the measured sample of interest in volts or counts.
• dark counts = the measured signal output in volts or counts of the sensor in clean

water with black tape over the detector.
• scale factor = the multiplier in µg/L/volt, ppb/L/volt, OR µg/L/count, ppb/L/count.

1. Get a solution of a known concentration, x.
2. Measure and record this solution using the sensor.

This value is the output in volts or in counts.
3. Measure and record the sensor's dark counts.
4. Use this equation to determine the sensor's scale factor:

Scale factor = x ÷ (output - dark counts).
5. Use the scale factor to determine the concentration of the sample of interest:

(output counts - dark counts) × scale factor = concentration of solution.
6. Store the scale factor and dark counts (offset) in the internal memory of the sensor.

Maintenance
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Section 8 Data QAQC

Current efforts are to follow the Quality Assurance-Quality Control of Real-Time Oceanographic Data (QARTOD) as written
by the US Integrated Ocean Observing System (IOOS).

QC flag values

Flag Value Description

Pass (green) 1 Data have passed the QC test and are deemed adequate for use.

Suspect (yellow) 2 Data are considered to be either suspect or of high interest.

Fail (red) 3 Data are considered to have failed QC tests or are missing.

QC tests

• Input voltage
• Wiper position (if so-equipped)
• Gross range
• Timing
• Date and time
• Median filter

Input voltage: does the sensor operate within the specified range of 7–15 V?

Flag Value Description

Pass 1 Input voltage is between 7 and 15 

Fail 3 Input voltage is below 7 or above 15 

Wiper position: is the wiper in the correct position for operation?

Flag Value Description

Pass 1 Wiper is in the correct position

Fail 3 Wiper is not in the correct position

Gross range: is the output a numeric value within the specified range of 0–65,536 counts?

Flag Value Description

Pass 1 Any value between 0 and 65,536 

Fail 3 Any value higher than 65,536 or any negative value

Timing: does the frequency of the user-selected data output agree with the frequency of data output from the sensor?

Flag Value Description

Pass 1 The user-selected output frequency agrees with the sensor output frequency

Fail 3 The user-selected output frequency does not agree with the sensor output frequency

Date and time: does the date and time show in a valid format?

Flag Value Description

Pass 1 The date and time show in a valid format

Fail 3 The date and time show in something other than a valid date format

Median filter: removes spikes from the raw data set. The filter window can be adjusted to the variance in the data set to the
expected variance time scale, e.g. tidal. The median filter replaces the QARTOD spike test with the advantage that the
threshold does not have to be set by the operator for each measurand.
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Section 9 ECO V2 terminal command set

The user can send terminal commands from a terminal program or the UCI software. The
table below lists commands and functions, where Y = 1, N = 0.
Commands are not case-sensitive: GetCD is the same as getcd.

Always active

ECO V2 command Description

GetCD show configuration data

GetEC show event counters

GetHD show hardware information

GetSD show status data

GetCC show calibration coefficients

GetQA show QA flags

GetDarkCounts show calibration dark count minimum, maximum, average

GetPower show the XML response with power levels for each stage of a sample interval. This information also
shows in the response to GetHD.

GetRanges show maximum measurement range for each channel

GetFS show factory settings

GetOutStr shows current OutStr in verbose mode

OutStr=O show current output index

GetOT show current output table

OTRevision show output table revision number

Help show a list of commands

TS take a single sample

TSS take and store a single sample

SL send last sample in OutStr format

Only active in standby mode

ResetEC reset all event counters

QS put sensor in low power mode ("quiescent")

ShowDefaultOutStr
show default output

ShowDefaultOutput

ReloadDefaultOutput load the default output to the current OutStr, delimiter, and OutputFormat

ShowDefaultCal show the manufacturer-set calibrations; do not load them over the current settings

DateTime set date and time (mmddyyyyhhmmss)

BaudRate=x set baud rate to x. Send command twice, the second time at the new baud rate.

TBaudRate temporarily set the baud rate to tBR. The baud rate reverts to the previous baud rate when power is
turned off, then on. Requires confirmation.

OutputCRC=x controls the CRC output in OutStr. If x=1, the CRC output is transmitted. If x=0, the CRC output is
not transmitted.

OutputExecutedTag controls the output of an <Executed/> tag
X=1: the tag shows. X=0: the ECOV2 prompt shows

EraseMemory erase all stored sample data
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EraseMemory=x erase all stored sample data pages from 0 to x

EraseMemory=all erase all stored sample data pages

TXRealTime=x x=y: transmit real-time data. x=n: do not

Delimiter=d set OutStr delimiter to d, where d=C for comma, d=T for tab, d=S for space.

Outsr Shows ASCII command format of user-selectable settings so the current configuration can be
loaded again at a later date/time.

GetUserSettings shows a subset of GetUserSettings and does not require that Factory Mode is enabled

AnalogOut=A,M,C,R set analog A (1–2) to transmit M (1–4) with calibration C (1–2) with a full range display of R, where
a maximum value of R shows with the GetRange command

AnalogOut=A,0,0,0 turn off analog A

AnalogOut=A,0,0,n.nn set analog A to a constant n.nn volts of output, where n.nn is 0.00 to 4.950 

AutoRun=x x=1 or Y: starts when power is supplied.
x=0 or N: does not

BurstSize=x x=number of samples to take each sample period. If x=0, the sensor operates continuously. Range:
0-86400.

BurstInterval=x set sample interval in seconds between the start of the Bursts. Range is 10–86400.

NumberofBursts=x set the number of data burst to be collected to x. If x=0 the sensor operates bursts or intervals
continuously

DataRateHz set the data rate to Hz. If DataRateHz is sent without a parameter the current data rate shows.

StartNow start data collection. The sensor uses the parameters shown in GetCD.

StartDateTime=x x=mmddyyyyhhmmss. Set the date and time to start the burst sequence. Used before the StartLater
command.

StartLater schedule the ECO to start data collection at the time set in StartDateTime

GetSamples transmit all samples between sample number X and sample number Y with the OutStr format.
Sample number starts at 0.

GetSamples=x, y

mvs operates the wiper one time

Get1Hz
get and show the 1 Hz clock count value

g1hz

TSN take x samples (samples are not stored)

Active only during data collection

Stop stop data collection (software only)

!!!!!
stop data collection

esc esc esc (push three times)

9.1 Details on output string (OutStr) index and output table (GetOT)
The output string (OutStr) contains values from the output table (GetOT) to configure the
ECO V2 output.
The two sections below use an ECO V2 triplet with memory and a real-time clock
configured to measure chlorophyll at 470 nm, backscattering at 700 nm, and fDOM at
370 nm as an example.

ECO V2 terminal command set
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9.1.1 ECO V2 output string index
The manufacturer-supplied OutStr is:
OutStr=0,3,7,30,31,33,55,56,60,59,80,81,83,195 
The response to GetOutStr is:
<OutStr string='FrameSync,USDateFormat,Time,M1_LTC,M1_RawScale,
M1_CAL1Units,M2_LTC,M2_RawScale,M2_CAL1AltUnits,M2_CAL2Units,M3_LTC,M3_
RawScale,M3_CAL1Units,vMain'/>

Index Description Units Range

0 FrameSync: xxxxx is 5-digit serial number ECOV2-xxxxx

3 US date format mm/dd/yy

7 Time hh:mm:ss 00:00:00–23:59:59 

M1: Chl-470

30 LED temperature compensation counts 0-65535 

31 RawScale (digital) output counts 0-655,350 

33 engineering values, Cal1 µgL-1 0–400 

M2: Backscattering-700

55 LED temperature compensation counts 0-65535 

56 RawScale (digital) output counts 0-655,350 

60 engineering values, EngAlt x.xxxE-yy output, Cal1 m-1 sr-1 0–9.500E-01 

59 engineering values, Cal2 NTU 0-350 

M3: fDOM-370

80 LED temperature compensation counts 0-65535 

81 RawScale (digital) output counts 0-655,350 

83 engineering values, Cal1 ppb 0–900 

195 main voltage volts 0–16 VDC

ASCII ECO V2 output:

Notes:

• RawScale output transparently combines digital output from a measurand's high-gain
and low-gain detector stages such that the calibration coefficients for the hi-gain
stage can be used to recalculate the engineering values in off-line post-processing.

• To change the output from tab-delimited to comma-delimited, simply add index 224 to
the OutStr command:
OutStr=0,3,7,30,31,33,55,56,60,59,81,83,195,224
The output changes to:

ECOV2-00278,02/17/25,23:24:27,30635,211,0.915,23143,2358,3.147E-03,46905,3591,38.435,11.80 

ECO V2 terminal command set
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9.1.2 Output table (GetOT)
The indices used by OutStr in the example output string above are shown in bold below.
< OutputTable DeviceType='ECOV2' SerialNumber='00278' Revision='3'>
<Idx Type='Frame' Key='FrameSync'>0</Idx>
<Idx Type='ASN' Key='FrameSyncHeader'>1</Idx>
<Idx Type='NSN' Key='Numeric-SN'>2</Idx>
<Idx Type='Date' Key='USDateFormat' Format='MM/DD/YY'>3</Idx>
<Idx Type='Date' Key='EURODateFormat' Format='DD/MM/YY'>4</Idx>
<Idx Type='DandT' Key='ISO-DateTimeMS' Format='YYYY-MM-
DDTHH:MM:SS.TTT'>6</Idx>
<Idx Type='Time' Key='Time' Format='hh:mm:ss'>7</Idx>
<Idx Type='Time' Key='TimeMS' Format='hh:mm:ss.ttt'>8</Idx>
<Idx Type='AI' Key='Counter' Plot='No'>9</Idx>
<Idx Type='AI' Key='Countdown' Plot='No'>10</Idx>
<Idx Type='AI' Key='SampleNumber' Plot='Yes'>11</Idx>
<Measurement id='CHL-470'>
<Idx Type='AI' Key='CHL-470 EX Wavelength' Units='nm' Plot='No'>25</Idx>
<Idx Type='AI' Key='CHL-470 EM Wavelength' Units='nm' Plot='No'>26</Idx>
<Idx Type='AI' Key='CHL-470 HiGain' Units='Counts' Plot='Yes'>27</Idx>
<Idx Type='AI' Key='CHL-470 LoGain' Units='Counts' Plot='Yes'>28</Idx>
<Idx Type='AI' Key='CHL-470 5 Volts' Units='Counts' Plot='Yes'>29</Idx>
<Idx Type='AI' Key='CHL-470 LTC' Units='Counts' Plot='Yes'>30</Idx>
<Idx Type='AI' Key='CHL-470 ScaledRaw' Units='Counts' Plot='Yes'>31</Idx>
<Idx Type='AF' Key='CHL-470' Units='ug/l' Plot='Yes'>33</Idx>
<Idx Type='AF' Key='CHL-470 EngAlt' Units='ug/l' Plot='Yes'>35</Idx>
</Measurement>
<Measurement id='BackScattering-700'>
<Idx Type='AI' Key='Beta-700 EX Wavelength' Units='nm' Plot='No'>50</Idx>
<Idx Type='AI' Key='Beta-700 EM Wavelength' Units='nm' Plot='No'>51</Idx>
<Idx Type='AI' Key='Beta-700 HiGain' Units='Counts' Plot='Yes'>52</Idx>
<Idx Type='AI' Key='Beta-700 LoGain' Units='Counts' Plot='Yes'>53</Idx>
<Idx Type='AI' Key='Beta-700 5 Volts' Units='Counts' Plot='Yes'>54</Idx>
<Idx Type='AI' Key='Beta-700 LTC' Units='Counts' Plot='Yes'>55</Idx>
<Idx Type='AI' Key='Beta-700 ScaledRaw' Units='Counts' Plot='Yes'>56</Idx>
<Idx Type='AF' Key='Beta-700' Units='m-1 sr-1' Plot='Yes'>58</Idx>
<Idx Type='AF' Key='Beta-700 EngAlt' Units='m-1 sr-1' Plot='Yes'>60</Idx>
<Idx Type='AF' Key='NTU-700' Units='NTU' Plot='Yes'>59</Idx>
</Measurement>
<Measurement id='fDOM'>
<Idx Type='AI' Key='FDOM EX Wavelength' Units='nm' Plot='No'>75</Idx>
<Idx Type='AI' Key='FDOM EM Wavelength' Units='nm' Plot='No'>76</Idx>
<Idx Type='AI' Key='FDOM HiGain' Units='Counts' Plot='Yes'>77</Idx>
<Idx Type='AI' Key='FDOM LoGain' Units='Counts' Plot='Yes'>78</Idx>
<Idx Type='AI' Key='FDOM 5 Volts' Units='Counts' Plot='Yes'>79</Idx>
<Idx Type='AI' Key='FDOM LTC' Units='Counts' Plot='Yes'>80</Idx>
<Idx Type='AI' Key='FDOM ScaledRaw' Units='Counts' Plot='Yes'>81</Idx>
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<Idx Type='AF' Key='FDOM' Units='ppb' Plot='Yes'>83</Idx>
<Idx Type='AF' Key='FDOM EngAlt' Units='ppb' Plot='Yes'>85</Idx>
</Measurement>
<Idx Type='AF' Key='vMain' Units='Volts' Plot='Yes'>195</Idx>
<Idx Type='AI' Key='QASummary' Plot='No'>200</Idx>
<Idx Type='AS' Key='NumericQA' Plot='No'>201</Idx>
<Idx Type='AS' Key='HexQA' Plot='No'>202</Idx>
<Idx Type='Format' Key='Variable'>215</Idx>
<Idx Type='Format' Key='Fixed'>216</Idx>
<Idx Type='Delimit' Key='Space' Chars='\x20'>223</Idx>
<Idx Type='Delimit' Key='Comma' Chars='\x2c'>224</Idx>
<Idx Type='Delimit' Key='Tab' Chars='\x09'>225</Idx>
</OutputTable>
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Section 10 Software reference

When the sensor operates with the UCI software, the three tabbed windows typically
show. The user can change the size of the windows and move them around outside the
main UCI window. The software is very flexible about how and where windows are
located. Windows can "float" or be "docked" as necessary.

1 Dashboard Sensor-specific, with status data and operational controls

2 Views:

• Real-time Data
• Data Collection
• Acquisition Monitor
• Message File

Information about data collection

3 Time Series View of real-time data, a plot of saved data, or a plot of QA analysis

4 Menus UCI, Sensor, Data, View, Window, Help

10.1 Sensor dashboards
The Dashboard is the main area from which to control and communicate with the sensor.
Information about the status of the sensor is contained in the upper part of the window
and is updated each time the sensor is connected to the software. To see the dashboard,
select it from the View | Dashboards menu item.
Common settings

• Connect-Disconnect lets the user disconnect the sensor after it is set up for
operation.

• Start-Stop lets the user start and stop data collection.
• Sensor Settings lets the user select options for a specific deployment.
• Deployment Wizard lets the user select a deployment mode, start time, the

parameters to measure, estimate the deployment time and data collection interval,
and make a summary report of the status of the sensor.

• Transmit Data lets the user move data saved on the sensor to a PC.
• Show Saved Data lets the user see data that was saved on a PC in a graph.
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• Command Terminal lets the user send terminal program-level commands to the
sensor.

10.1.1 ECO V2 settings
ECO V2-specific settings:

• Sleep puts the sensor in a low power mode.
• Replay Logged Data lets the user select a .sbsdat file type and to show in the Time

Series window of the sensor.
• Run Data Analysis Filters is a six-step wizard that lets the user do a QAQC analysis

of data.
• Check Wiper lets the user operate the anti-fouling wiper for one cycle.

Many of the sensor settings can be changed with the ECO V2 Settings button in the
Dashboard. The options are almost the same as those in the Deployment Wizard.

• Output format—push Modify Format to see a list of available data parameters.
Select or deselect parameters here or in step 2 of the Deployment Wizard. Refer to 
Output description on page 19 for details about the available parameters.

• Samples—Select the sample settings and interval.
The "Data Rate" is 1, 2, or 4 Hz.
Put a check in the box at "Start Sampling at Power Up" to set the sensor to come on
when the power is turned off and then on again. The mode of operation will be the
saved settings from the Samples tab.
Burst Settings: Put a check at "Sample Continuously" or remove the check to set a
user-specified interval:

• Continuously: the sensor operates at the selected Hz rate. (Default = 1).
• Interval:

• Burst start interval—Select a time to start data collection. Set to one day or
up to 23:59:59.

• Number of samples per burst—Select the number of samples to collect
during x bursts. Range is 1–86400 and is dependent on the start interval.

• Number of bursts—Select the number of times, or bursts, that the sensor
collects data.

Push Apply to save the settings in the sensor.
Push Default to see the manufacturer-set values for data collection:

• Burst start interval: 00:15:00.
• Number of samples per burst: 4.
• Number of bursts: 10.

• Transmit Data—Add or remove the check to transmit data in real time to a controller
when the sensor operates in autonomous mode.

• Baud Rate—The software automatically determines the baud rate at which the sensor
transmits data. (Default=19200).

• Analog Output—Select which of the available data measurements are to be output on
either of the two analog outputs. If analog outputs are not needed, select the None
option. The "Max Range" field can be used to specify the engineering units value for
a measurement that corresponds to the typical maximum analog output voltage of
4.95 volts.

10.2 View options
The options in the View menu let the user see information about the status of data
collection.
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Dashboards— Go to the View menu and Dashboards to select the dashboard for a
specific sensor.
Graphs— Go to the View menu and select Time Series to see data in real-time. Refer to 
Time series on page 41 for details about the options to see data.
Output— Go to the View menu and select Output, then any of the three options:

• Instrument Console: see the current settings in the sensor, and data in real time.
• Processing Console: the data collected by the sensor in a comma-delimited format
• Application Console: the commands sent to the sensor from the software.

Real Time Data— Go to the View menu and select Real Time Data to select the
parameters that the specific sensor will use for data collection.
Data Collection —Go to the View menu and select Data Collection to select the location
on the PC in which the collected data is saved.
Acquisition Monitor —Used by the manufacturer for troubleshooting.
Message File —Used by the manufacturer for troubleshooting.

10.3 Time series
The Time Series graph lets the user see data in real time. There are a number of options
available to adjust how data shows.

• Select QAQC Filters—Select "Pass," "Suspect," or "Fail" to identify any data that
meets the selected filter criteria. Default: all are selected.

• Select Sensors To Display—Select the parameters to show in the Time Series
window. The sensor collects data for all parameters. This selection just lets the user
choose what to see. The maximum number of parameters for a plot is 12.

• Controls—

• Use Zoom In and Zoom Out to change the level of detail that shows. More detail
is available if "Time Axis" or "Range Axis" is selected. Push Auto Range or
Default Ranges to go to the default display settings.

• Dark Scheme changes the background to a dark color.
• "Show Data Points"—A check in this box (default) shows data points. If there is

no check, the data shows as lines only.

Other options

• Use the scroll wheel on a mouse to zoom in or out on data.
• Click anywhere in the Time Series graph to add a vertical line near data to zoom in

on, then drag the mouse to see more detail.
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The Time Series graph is enabled by default. To disable this graph:

1. Select the UCI menu, then Preferences.
2. Select Display.
3. Remove the check in the box at "Enable Time Series Graph."
4. Push Apply, then OK.

10.4 UCI software menus
10.4.1 UCI menu

The user can set up the way that the software saves information about the operation of
the sensor and change the way that the data looks from the Preferences menu.

10.4.1.1 General tab
Enter or change the directory on the PC in which data from the sensor is stored.

• "Maximum Wakeup Attempts" lets the user select the number of times the software
will try to connect to a sensor. Range: 5–15.

• "Response Timeout" is the interval of time between communication between the
sensor and the software. Range: 5–10.

• "Default Data Directory" lets the user enter the location on the PC in which to save
data from the sensor. If there is a check in the "Prompt at startup" box, the user can
change the directory in which the data is stored every time the software starts.

10.4.1.2 Display tab
Note: The software operates faster if the user selects less data and only one or two graphs.

Data that is collected by the sensor shows in the user-selected graphs in the
Performance Optimization Settings area of the Display tab.

• "Enable Real Time Display"—Put a check in this box to see the data as it is collected
in either the software, or if deployed, a terminal program.

• "Enable Time Series Graph"—Put a check in this box to see user-selected data.
Remove the check in the box to so that the graph is disabled and the data does not
show.

• SUNA only: "Enable Spectra Graph"—Put a check in this box to see both dark and
light data in raw counts. Refer to Monitor spectra for details.

• SUNA only: "Enable Total Absorbance Graph"—Put a check in this box to see the
calculated absorbance. Refer to Monitor absorbance for details.

Time Series Settings—The default is a check in the box for continuous data collection
that is not limited to a specified amount of time. Remove the check in the box to enable
the "Time Axis Range Limit" of 60 minutes (default value). Only the most recent hour of
data will show in the Time Series Graph. The user-selectable range is 1–1440 minutes.

10.4.1.3 Message tab
The software automatically saves files that have information about sensor use, data
collection, and software operation over time. This information helps the user and
Customer Support find problems and troubleshoot.
When the "Display Dialog for Error Level Messages" box has a check in it, the software
saves one of five levels of error messages.

• INFO—The default level. All high-level operations are saved.
• ERROR—Minimum level. Only errors that need to be examined by the user or

Customer Support are saved.
• WARN—Low level. The files that are saved do not have enough information for the

user to make an analysis of how the sensor is used and set up.
• DEBUG—High level. Used to troubleshoot. DEBUG and TRACE files are very large.
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• TRACE—The highest level. Used only to troubleshoot.

"Daily Files"—all messages from a single day are saved in one file.
"Rolling Files"—all messages are saved in one file until it is the maximum size specified
by the user. The messages are then saved to a new file. The user specifies the number of
files to keep. The oldest files are erased first.
"Save Lost Bytes"—if this box has a check in it, the software saves all of the unexpected
output from the sensor to a file.
"File Location"—the operating system of the PC determines where these files are saved.

10.4.2 Sensor menu
The Sensor menus have options for each sensor with which the software communicates.
Refer to the sections on Sensor dashboards on page 39 for more information about these
items.
Advanced Sensor menu items
Common

• Erase Data lets the user erase all of the data stored in the sensor.
• Summary Report lets the user get a summary of the settings stored in the sensor.
• Set Clock lets the user synchronize the time between the PC and the sensor.
• Collect Diagnostics is helpful for troubleshooting.
• Optional: Pair Optics Cal Cap lets the user enter the serial number of a new check

cap to connect, or "pair" it with the sensor.
• Optional: Upgrade Firmware lets the user install the latest firmware from the

manufacturer.

10.4.2.1 ECO V2

• Erase Saved Data lets the user erase all of the data saved in the sensor.
• Deployment Endurance lets the user estimate how long the batteries will last for a

specific deployment.
• Upgrade Firmware lets the user install the latest firmware from the manufacturer.
• Load Factory Defaults lets the user install the manufacturer-set configuration settings.
• Restore Settings from File lets the user configure the settings previously stored in the

PC.
• Enter Legacy Mode lets the user put the ECO V2 into legacy mode. Because legacy

mode is not currently compatible with UCI, the ECO will be disconnected after being
put into legacy mode.

10.4.3 Data menu
The Data menu has sensor-specific options to look at data that has been saved to a PC.

10.4.3.1 Export data to .csv or MS Excel format
Data from the sensor can be saved to either a comma-separated (.csv) file or a
Microsoft® Excel file with a local or UTC time stamp. Use the software to transmit data
from the sensor and then export that data to a human-readable format.

1. From the Data menu, select Export Stored Data.
2. Push Browse to find the file to export.
3. Select the file from the list.
4. Push Open.
5. Push Next. The current output format shows (all sensors but SUNA).
6. Push Next. Select the options for the file to export:

a. Select either "Excel Workbook" or "Comma Separated Values" in Export File
Format.
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b. Select the "Local" time stamp in Format Options.
7. Push Browse to select the directory in which the exported data will be saved.
8. Push Finish.

10.4.3.2 Show data from multiple sensors
The software lets the user show data that has been saved on the PC from each
supported sensor. The user can select up to 12 parameters to look at.

1. Go to the Data menu, then Show Data from Sensor.
2. Go to the area of the first supported sensor and push Browse to go to the .csv file-

type.
3. Select the file, then push Open.
4. Push Select Sensors to Show.
5. Put a check in the box of each parameter to look at in the Time Series graph.
6. Push OK.

10.4.3.3 ECO V2 data menu
Replay Data
Lets the user select a .sbsdat file to show in the Time Series window.
Data Analysis Filter
A six-step wizard that lets the user do a QAQC analysis of data.
QA Processed data
Select a .csv file type to make a graph of processed data.

10.4.4 View menu
Dashboards— Go to the View menu and Dashboards to select the dashboard for a
specific sensor.
Graphs

• Time Series Graphs—all supported sensors.
• SeaFET—Processed pH graph.
• SUNA—Spectra, Absorbance, or Reprocessed Nitrate.
• SUNA Spectra graph: the user can push Configure to change the number of graphs

to view. The "Graph History Limit" range is 1–2147483647. Put a check in the "Graph
History Unbounded" box to see the total number of graphs. Default value: no check in
the box and a "Graph History Limit" of 1.

• SUNA Absorbance graph: the user can change the "Min. Wavelength Cutoff" to
between 150–400 nm to change the scale of the graph. Push Configure to change
the number of graphs to view. The "Graph History Limit" range is 1–2147483647. Put
a check in the "Graph History Unbounded" box to see the total number of graphs.
Default value: no check in the box and a "Graph History Limit" of 1.

• SUNA Reprocessed Nitrate graph: the user may find that it helps to reprocess data
under some conditions.

Output— Go to the View menu and select Output, then any of the three options:

• Instrument Console: the current settings in the sensor
• Processing Console: the data collected by the sensor in a comma-delimited format
• Application Console: the commands sent to the sensor from the software.

Real Time Data— Go to the View menu and select Real Time Data to select the
parameters that the specific sensor will use for data collection.
Data Collection— Go to the View menu and select Data Collection to select the location
on the PC in which the collected data is saved.
Acquisition Monitor— Used by the manufacturer for troubleshooting.

Software reference

44



Message File— Used by the manufacturer for troubleshooting.

10.4.5 Window and Help menus
The user can change how the software shows different windows and tabs. The Help
menu has the .pdf version of the user manuals for supported sensors and this software
reference.

• Close Current Window—closes the selected tab (highlighted in blue).
• Close all Windows—closes all tabs except the UCI Dashboard.
• Configure Window—

Maximize: increases the size of the selected tab to fill the software screen size.
Float: unlocks the selected tab from the software screen so that the user can move it
to other locations on the PC screen.
Float Groups: the same as Float above, but all tabs that are open are unlocked so
that the user can move them to other locations on the PC screen.
Minimize: minimizes the selected tab and moves it to the side of the software screen.
Minimize Group: minimizes the open tabs in the "Console," "Dashboard," or "Graph"
areas of the software.
Dock: locks the tab that the user selected to "float" back to its previous position in the
software window.
Dock Group: the same as Dock above, but all tabs that are open are locked back into
their previous position in the software window.
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Section 11 General information

Revised editions of this user manual are on the manufacturer's website.

11.1 Warranty
Refer to the manufacturer's website for warranty information (seabird.com/warranty).

11.2 Service and support
The manufacturer recommends that sensors be sent back to the manufacturer annually to
be cleaned, calibrated, and for standard maintenance.
Refer to the website for FAQs and technical notes, or contact the manufacturer for
support at support@seabird.com. Do the steps below to send a sensor back to the
manufacturer.

1. Complete the online Return Merchandise Authorization (RMA) form or contact the
manufacturer.
Note: The manufacturer is not responsible for damage to the sensor during return shipment.

2. Remove all batteries from the sensor, if so equipped.
3. Remove all anti-fouling treatments and devices.

Note: The manufacturer will not accept sensors that have been treated with anti-fouling
compounds for service or repair. This includes AF 24173 devices, tri-butyltin, marine anti-
fouling paint, ablative coatings, etc.

4. Use the sensor's original ruggedized shipping case to send the sensor back to the
manufacturer.

5. Write the RMA number on the outside of the shipping case and on the packing list.
6. Use 3rd-day air to ship the sensor back to the manufacturer. Do not use ground

shipping.
7. The manufacturer will supply all replacement parts and labor and pay to send the

sensor back to the user via 3rd-day air shipping.

11.3 Lithium battery shipment

W A R N I N G
 

Do not ship the sensor with the batteries installed. Do not ship the battery pack for the sensor with
the batteries installed.

The information below is general. It gives guidance only to appropriately trained shipping
personnel. Refer to the IATA Dangerous Goods Regulations for complete information
about shipping lithium batteries.
The manufacturer ships the lithium cells with the sensor in a separate box. Each of the
12 cells is packed in heat-sealed plastic. All batteries are packed in bubble wrap in a
sturdy box.
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Batteries that are shipped without the sensor are Dangerous Goods. They can only be
shipped by personnel with the appropriate training from an organization that has a
Dangerous Goods program.

Sensor, no spares Sensor, 1 or 2 spare cell sets Cells only

UN # 3091 3090 

PI # 969 968 

Passenger aircraft yes no

Cargo aircraft yes

Label requirements

--
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Appendix A Configure sensor for ECO "Classic" output

To use an ECO V2 where a "Classic" was used, configure the V2 output to look like the
"Classic" output :

• The output is limited to approximately 20 bits (4130 maximum counts) using the
ScaledRaw output

• The output is limited to ECO V2 high gain range
• The output does not have QAQC data.

When the sensor is in Legacy Mode, use the MxLegacyRange command to see the
maximum range available for each measurement.
Use a terminal emulator program to change the output format of an ECO V2 to look like
ECO "Classic." The commands below will put the ECO V2 into Legacy Mode so that the
data collected is the same format and scaling of ECO Classic sensors.
Quick start steps:
Step 1: Enter Legacy Mode and select ECO Classic format with the sequence command.
Step 2: Select the range of the output for each channel.
Step 3: Look at and save the legacy calibration coefficients (dark counts and scale
factors) for each channel.
Send the $run, StartNow, or StartLater (non-real-time sensors) command to start
data collection.

A.1 Example setup
IMPORTANT

• The sensor cannot be in data collection mode while it is changed to or from legacy
output.

• If the sensor is equipped with memory, the data will be stored in the ECO V2 format,
with range, precision, QAQC, even if it is in Legacy Mode.

• The calibration coefficients below are different from those for normal ECO
V2 operation. These calibration coefficients are legacy-dependent and MUST be
recorded for each channel every time you enter Legacy Mode or change a Legacy
Range.

• Legacy Mode commands use CAL 1 in the ECO V2 to scale the Legacy Counts. To
set the output scaled to CAL 2, (to access an NTU calibration on a backscattering
700 nm measurement, for example), use the MxSwapCal command to change the
locations of CAL 1 and CAL 2. The Legacy Mode commands can then access the
second calibration, which is now in the CAL 1 location. Use the GetCC command to
identify the locations and types of the calibrations.

• Commands, responses, and comments for Steps 1–3:

• Bold: the command entered by the user, followed by Enter.
• Normal: the response to the command.
• Italics: the comments to the command.

A.1.1 Step 1: Enter Legacy Mode and select Classic output
Stop Stops data collection

<!--sampling stopped--> or <Executed/>
Enter Push Enter to get the <Executed/> or ECOV2> response.

<Executed/>
$seq 0 Enter legacy mode, set output to Sequence 0.

$seq 0 Enter '$seq 0' again to confirm that Sequence 0 is the default ECO Classic output.
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<$seq='0'/>
<Executed/>
GetLegacyRanges
<LegacyRanges DeviceType='ECOV2' SerialNumber='10001'>
<LegacyRange measurement='1' id='CHL-470' max='400' units='µg/l'>400</LegacyRange>
<LegacyRange measurement='2' id='Backscattering-700' max='9.500000e-01'
units='m-1 sr-1'></LegacyRange>
<LegacyRange measurement='3' id='FDOM' max='900'
units='ppb'></LegacyRange></LegacyRanges>
<Executed/> The current range, maximum range, and units show for each measurement.

A.1.2 Step 2: Select the output range for each channel
mxlegacyrange=1,100 Set range of measurement 1,

CHL, to 100 µg/L.

<LegacyRange measurement='1' id='CHL' max='400' units='ug/l'>100</LegacyRange>
<Executed/> Note: measurement 2 is not

changed in this example.

mxlegacyrange=3,200 3=the number of the
measurement to show

<LegacyRange measurement='3' id='FDOM' max='900' units='ppb'>200</LegacyRange>
<Executed/>

A.1.3 Step 3: Show and save the calibration coefficients
GetCC Get the legacy range calibration coefficients

<CalibrationCoefficients DeviceType='ECOV2' SerialNumber='10001'>
<!--Legacy Range = 100.0 ug/l-->

<SerialNum>10001</SerialNum>
<CalDate>1970-01-01</CalDate>
<Units>µg/l</Units>
<DarkCounts>50</DarkCounts> Dark counts for CHL.

<ScaleFactor>2.464461e-02</ScaleFactor> Scale factor for CHL.

</Calibration>
<Calibration format='ECO1' id='Backscattering-700' label='Beta-700'>

<!--Legacy Range=9.990000e-02 m-1 sr-1-->
<SerialNum>10001</SerialNum>
<CalDate>1970-01-01</CalDate>
<Units>m-1 sr-1</Units>
<DarkCounts>50</DarkCounts> Dark counts for bb-700.

<ScaleFactor>2.448539e-05</ScaleFactor> Scale factor for bb-700.

</Calibration>
<Calibration format='ECO1' id='FDOM' label='FDOM'>

Configure sensor for ECO "Classic" output
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<!--Legacy Range = 200.0 ppb-->
<SerialNum>10001</SerialNum>
<CalDate>1970-01-01</CalDate>
<Units>ppb</Units>
<DarkCounts>50</DarkCounts> Dark counts for FDOM.

<ScaleFactor>4.910981e-02</ScaleFactor> Scale factor for FDOM

</Calibration>
</CalibrationCoefficients>
<Executed/>

A.1.4 Stop ECO Classic output
Push the Enter key Gives the executed response.

<Executed/>
setLegacy=0 Turn off the ECO Classic output

<Executed/>
ts Take a sample to make sure V2 output shows.

ECOV2-10001 99:99:99 296 28 30000 1140 108 30250 829 79 30500 0 0 0 14.50 111222221
41414
<Executed/>

A.2 Legacy mode commands
Command Response

$Seq X Enter Legacy Mode and set the output to Sequence Number X. Sequence numbers are output
formats where X=0 for standard ECO Classic, X=1 for short, X=2 for long.
This command requires a command confirmation.

GetLegacyRanges Show the current Legacy Range settings.

MxLegacyRange=m,r Set the maximum output range for measurement m to range r.

MxDeleteLegacy=m Disable the legacy real-time output for a single measurement, m. The measurement m is still
recorded.
Used to disable a measurement output for a 4-measurand ECO V2 when data is collected with a
CTD that can only take three serial measurements as input.
Note that it is possible to accidentally turn off all measurement output. Use $seq or SetLegacy=1 to
turn them all back on.

GetCC Get the dark counts and scale factor for the current Legacy Range setting for each channel.
Engineering output = (LegacyCounts - DarkCounts) × ScaleFactor

MxSwapCal=m Changes calibrations 1 and 2 for measurement m. This setting will be kept when the power is
turned off, then on.

SetLegacy Get the current Legacy Mode status.

SetLegacy=0 Turn off Legacy Mode and set output to manufacturer defaults.

SetLegacy=1 Turn on Legacy Mode. Turn on all measurements for output in, and set output to Sequence 0.
Requires a command confirmation.
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A.3 Legacy output formats
Output sequences and formats

• RefX = reference wavelength
• SigX = signal in legacy counts
• SN = serial number of the sensor
• Temp = internal processor temperature measurement
• SFX = legacy scale factor
• DCX = legacy dark counts

Use the sequence command and a sequence number to enable a format. There are three
Classic output formats:

• Sequence 0, Standard (default)
99/99/99 99:99:99 Ref1 Sig1 Ref2 Sig2 Ref3 Sig3 Ref4 Sig4 Temp

• Sequence 1, Short
Sig1 Sig2 Sig3 Sig4 SN

• Sequence 2, Long
Sig1 Sig2 Sig3 Sig4 SN SF1 DC1 SF2 DC2 SF3 DC3 SF4 DC4

Notes on output

• The default output has all measurements turned on, is fixed-width and tab-delimited.
• Full range is 4130 counts.
• The minimum, or dark count, value is always 50.
• Temperature is always a 999 placeholder to align the number of fields from the ECO

Classic.
• When a sequence number is selected, all measurements are enabled.
• Use the MxDeleteLegacy command to disable one or more of the outputs from the

data. Once a measurement output is disabled, you must enter a sequence command
again to restore all output.

Configure sensor for ECO "Classic" output
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